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One of the most important functions of BPwin models is the ability to capture information about how 
business processes relate to a data processing system. For example, in a BPwin model you can identify 
which activities use stored data, which entities and attributes are used as process inputs, and which 
entities and attributes are created or modified by process outputs.

BPwin and ERwin support the EAX (ERwin-to-BPwin) and BPX (BPwin-to-ERwin) file formats to facilitate 
the exchange of entity and attribute information between a BPwin model and an ERwin diagram outside 
of ModelMart. The ModelMart Synchronizer, an independent application, provides the same type of 
functionality as the EAX and BPX file formats for models stored in ModelMart.

Using the ModelMart Synchronizer, you can synchronize:

n A BPwin model with an ERwin model. Choose this option to associate activities, entities, and 
attributes in a BPwin model with subject areas, entities, and attributes in a corresponding ERwin 
model.

n An ERwin model with a BPwin model. Choose this option to associate entities and attributes in an 
ERwin model with entities and attributes in a corresponding BPwin model.

The synchronization information is held in the BPwin model objects irrespective of the direction of the 
synchronization you choose.

Note: The ModelMart Synchronizer never deletes a BPwin or ERwin object from the ModelMart. It sets, 
updates, or clears BPwin object properties that reference ERwin objects, and creates new objects 
in the ERwin or BPwin model when necessary.

Related Topics
    Using the ModelMart Synchronization Wizard
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When you choose this option, the ModelMart Synchronizer searches for a match between:

n BPwin activities and ERwin subject areas.

n BPwin entities and ERwin entities.

n BPwin attributes and ERwin attributes.

The criteria used to match the objects depends on the synchronization option that you select. You can 
match objects by ModelMart name or ModelMart ID.

The ModelMart Synchronizer maintains a change list of all the changes that need to be made to the 
ERwin and BPwin models to complete the synchronization.

When a BPwin object matches an ERwin object, the synchronizer add a statement to the change list. 
The statement updates the BPwin object property that references the ERwin object with the ModelMart 
ID of the ERwin object. When a BPwin object does not match any existing ERwin object, the 
synchronizer adds statements to the change list to create the corresponding object in the ERwin model.

When the matching is complete, the synchronizer displays the change list. You can review the change 
list and accept or cancel changes as necessary.

Note: The ModelMart Synchronizer synchronizes a BPwin model with the logical ERwin model only. It 
has no effect on the physical ERwin model.

Related Topics
    Rules for Synchronizing BPwin Activities with ERwin Subject Areas
    Rules for Synchronizing BPwin Entities with ERwin Entities
    Rules for Synchronizing BPwin Attributes with ERwin Attributes
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The ModelMart Synchronizer synchronizes BPwin activities to ERwin subject areas according to the 
following rules:

n The synchronizer matches BPwin activities with ERwin subject area by ModelMart name only. In 
ModelMart, a BPwin activity object does not include a property that references an ERwin subject 
area. If a match is found, the synchronizer takes no action. If a match is not found, the synchronizer 
adds statements to the change list that create a new ERwin subject area for each unmatched 
BPwin activity.

n In the BPwin model, if a BPwin activity has one or more entity associations that have at lease one 
CRUD setting (or one or more attributes with at lease one IRUN setting), the synchronizer adds 
statements to the change list that include the corresponding ERwin entities in the ERwin subject 
area.

n When a BPwin activity is matched to an ERwin subject area by synchronization and a user 
subsequently changes the name of the subject area in ERwin, a new synchronization generates 
statements in the change list that create a new subject area in ERwin. The synchronizer cannot 
synchronize a BPwin activity to a corresponding ERwin subject area if the subject area name is 
changed.

n When the synchronizer adds statements to the change list to create a new subject area in ERwin, 
the statements specify a subject area with a single stored display that takes on the default stored 
display characteristics. You can manually set stored display characteristics according to your 
preference after the stored display is created.

Related Topics
    Synchronizing a BPwin Model with an ERwin Model
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The ModelMart Synchronizer synchronizes BPwin entities to ERwin entities according to the following 
rules:

n The synchronizer does not synchronize a BPwin entity that is marked BPwin Only with any ERwin 
entity, even if it finds a match by ModelMart name or ModelMart ID.

n When the synchronizer does not match a BPwin entity (either by name or ID) with any existing 
ERwin entity, it adds statements to the change list that create the corresponding entity in the ERwin 
model and set the BPEREntity property of the BPwin entity to the ModelMart ID of the newly 
created ERwin entity.

n When the synchronizer matches a BPwin entity to an ERwin entity by name (but not by ID), the 
synchronizer adds statements to the change list that set the BPEREntity property of the BPwin 
entity to the ModelMart ID of the ERwin entity. It does not add statements to the change list to 
change the name of the ERwin entity.

n When you choose to match by name and the synchronizer does not find a match between a BPwin 
entity and any existing ERwin entity, the synchronizer adds statements to the change list that 
create a corresponding ERwin entity in the ERwin model. It also adds statements that set the 
BPEREntity property of the BPwin entity to the ModelMart ID of the newly created ERwin entity. 
When reviewing changes before completing the synchronization process, you may choose to 
cancel these statement. If you do, and the BPEREntity property of the BPwin entity is already set to 
reference another ERwin entity, the BPEREntity property is not overwritten.

n ERwin entities, created as the result of a synchronization, are placed in the top left corner of the 
ERwin model. You must manually move each entity to the position you want.

Related Topics
    Synchronizing a BPwin Model with an ERwin Model
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The ModelMart Synchronizer synchronizes BPwin attributes to ERwin attributes according to the 
following rules:

n The synchronizer does not synchronize a BPwin attribute that is marked BPwin Only with any 
ERwin attribute, even if it finds a match by ModelMart name or ModelMart ID.

n When the synchronizer does not match a BPwin attribute (either by name or ID) with any existing 
ERwin attribute, it adds statements to the change list that create the corresponding attribute in the 
ERwin model.

n When the synchronizer adds statements to the change list that create an attribute in an ERwin 
model, the statements define the minimal set of attribute properties. Consequently, when you save 
an ERwin model to ModelMart for the first time following synchronization, the change list in the 
Change Control Manager shows many changes that involve setting attribute properties, such as 
datatype, data length, precision, nulls allowed, and so on.

n When you choose to match by ID and the synchronizer matches a BPwin attribute to an ERwin 
attribute by ID but not by name, the synchronizer adds statements to the change list that change 
the ERwin attribute name to the BPwin attribute name. However, you can cancel this change when 
you review changes before completing the synchronization.

Related Topics
    Synchronizing a BPwin Model with an ERwin Model
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When you choose this option, the ModelMart Synchronizer searches for a match between:

n ERwin entities and BPwin entities.

n ERwin attributes and BPwin attributes.

The criteria used to match the objects depends on the synchronization option that you select. You can 
match objects by ModelMart name or ModelMart ID.

The synchronizer maintains a change list of all the changes that need to be made to the ERwin and 
BPwin models to complete the synchronization.

When the synchronizer matches an ERwin object with a BPwin object, it add a statement to the change 
list. The statement updates the BPwin object property that references the ERwin object with the 
ModelMart ID of the ERwin object. When the synchronizer does not match an ERwin object with any 
existing BPwin object, it adds statements to the change list to create the corresponding object in the 
BPwin model.

When the matching is complete, the synchronizer displays the change list. You can review the change 
list and accept or cancel changes as necessary.

Note: The synchronizer does not update BPwin entity and attribute names when corresponding ERwin 
entity and attribute names change. In BPwin, entity and attribute names are not bounded, 
therefore the synchronizer cannot implement the name change.

The synchronizer synchronizes the logical ERwin model with a BPwin model only. It has no effect 
on the physical ERwin model.

Related Topics
    Rules for Synchronizing ERwin Entities with BPwin Entities
    Rules for Synchronizing ERwin Attributes with BPwin Attributes
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The ModelMart Synchronizer synchronizes ERwin entities to BPwin entities according to the following 
rules:

n When the synchronizer matches an ERwin entity by ID (but not by name) with an existing BPwin 
entity, it does not add statements to the change list that update the BPwin entity name.

n When the synchronizer does not match an ERwin entity (either by name or ID) with any existing 
BPwin entity, it adds statements to the change list that create the corresponding entity in the BPwin 
model. The synchronizer does not provide any CRUD information for the newly created BPwin 
entity and the entity is not associated with any BPwin activity.

Related Topics
    Synchronizing an ERwin Model with a BPwin Model
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The ModelMart Synchronizer synchronizes ERwin attributes to BPwin attributes according to the 
following rules:

n When the synchronizer matches an ERwin attribute by ID (but not by name) with an existing BPwin 
attribute, it does not add statements to the change list that update the BPwin attribute name.

n When the synchronizer does not match an ERwin attribute (either by name or ID) with any existing 
BPwin attribute, it adds statements to the change list that create the corresponding attribute in the 
BPwin model. The synchronizer does not provide any IRUN information for the newly created 
BPwin attribute.

Related Topics
    Synchronizing an ERwin Model with a BPwin Model
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You can start the ModelMart Synchronizer in two ways:

n As an independent application. The BPwin, ERwin, and ModelMart program groups contain a 
ModelMart Synchronizer icon that you can use to start the ModelMart Synchronizer.

n From within BPwin. In BPwin, if you have established a connection to ModelMart, you can click the 
ModelMart Synchronizer button on the ModelMart toolbar to open the ModelMart Synchronizer. 

Note: If you start the ModelMart Synchronizer and you already have an ERwin or BPwin connection to 
ModelMart, the ModelMart Synchronizer uses that connection. The Connect button in the main 
ModelMart Synchronizer dialog changes to Disconnect when an existing connection to ModelMart 
is detected.

Related Topics
    To start the ModelMart Synchronizer
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n Choose one of the following:

n In Windows 95 or Windows NT version 4.0, click Start, point to Programs, then <Logic Works 
Program Group>, then click ModelMart Synchronizer.

n In Windows NT version 3.51, open the <Logic Works Program Group> and double-click the 
ModelMart Synchronizer icon.

The main ModelMart Synchronizer window opens.

Note: The <Logic Works Program Group> mentioned above can be Logic Works BPwin 2.02, Logic 
Works ERwin_ERX 3.5, or Logic Works ModelMart Manager.

If you have BPwin open, and a connection to ModelMart established, you can click the ModelMart 

Synchronizer button  on the ModelMart toolbar to start the ModelMart Synchronizer.
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When you start the ModelMart Synchronizer the main window is displayed. See Starting the ModelMart 
Synchronizer  for more information.

You can synchronize a BPwin model in ModelMart with an ERwin model in ModelMart or vice-versa 
using the following steps:

1. Connect to the ModelMart that contains the models you want to synchronize. More>> 

2. Choose the direction of synchronization ERwin diagram to BPwin model or BPwin model to ERwin 
diagram. More>> 

3. Select the BPwin model and ERwin diagram you want to synchronize. More>> 

4. Select the method of synchronization, that is match objects by ModelMart Name or by ModelMart 
ID. More>> 

5. Click the Sync Now button to start the synchronization process. The ModelMart Synchronizer 
displays the ModelMart Change Control Manager with a list of changes that must be made to 
synchronize the models.

6. Review the changes and cancel them as required. More>> 

7. Click OK when you are satisfied with the changes in the change list.

Related Topics
    Synchronizing BPwin and ERwin Models in ModelMart
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1. Click the Connect button in the main ModelMart Synchronizer window. The ModelMart 
Connection Manager dialog displays.

2. Enter your login name and password for the ModelMart database.

3. Choose one of the following:

n Click the Advanced button, and select your ModelMart connection settings from the History 
list, if you had typed the ModelMart connection information previously.

n Click the Advanced button, and specify the ModelMart connection information as follows:

n If the ModelMart is installed in a Microsoft SQL Server or Sybase DBMS:

Select the appropriate DBMS version and connection library (for example, SQL Server 
Vers. 6 - using db-lib) in the Host DBMS box.

Type the server name (for example, sql6) in the DBMS Connection box.

Type the name of the database that contains the ModelMart Control Tables (for example, 
erwinmm) in the ModelMart Master Database box.

n If the ModelMart is installed in an Oracle DBMS:

Select the appropriate DBMS version (for example, Oracle Vers. 7.x) in the Host DBMS 
box.

Type the connection string (for example, mm.world) in the DBMS Connection box.

n If the ModelMart is installed on an INFORMIX server:

Select the appropriate DBMS version (for example, INFORMIX version 7/9.xx) in the Host 
DBMS box.

Type the name of the ODBC data source you are using to access the INFORMIX database 
in the DBMS Connection box.

4. Click OK. A connection with the selected server is established.

Note: If you start the ModelMart Synchronizer from BPwin or ERwin, the ModelMart Synchronizer uses 
the BPwin or ERwin connection and you do not have to log on to ModelMart again. The Connect 
button in Step 1 above changes to Disconnect when a connection between the ModelMart 
Synchronizer and the ModelMart is active.

Related Topics
    Using the ModelMart Synchronizer
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n Choose one of the following options in the Operation group box:

n To associate activities, entities, and attributes in a BPwin model with subject areas, entities, 
and attributes in a corresponding ERwin model, choose Update ERwin Diagram from BPwin 
Model. See Synchronizing a BPwin Model with an ERwin Model   for more information.

n To associate entities, and attributes in an ERwin model with entities and attributes in a 
corresponding BPwin model, choose Update BPwin Model from ERwin Diagram. See 
Synchronizing an ERwin Model with a BPwin Model   for more information.

Related Topics
    Using the ModelMart Synchronizer
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1. Click the Browse button next to the BPwin Model to Synchronize From or the ERwin Diagram to 
Synchronize From box in the Files to Synch group box. The Open ModelMart Model dialog is 
displayed. 

2. Select the libaray that contains the model you want to synchronize from, then select the model and 
click OK.

3. Click the Browse button next to the ERwin Diagram to Update or the BPwin Model to Update 
box in the Files to Synch group box. The Open ModelMart Model dialog is displayed.

4. Select the libaray that contains the model you want to synchronize to, then select the model and 
click OK.

Related Topics
    Using the ModelMart Synchronizer
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1. Click the Options button in the ModelMart Synchronizer window. The Synchronizer Options 
dialog is displayed.

2. Choose one of the following options:

n To match BPwin and ERwin model objects by ModelMart ID, click ID in the Match By group 
box.

n To match BPwin and ERwin model objects by ModelMart name, click Name in the Match By 
group box.

Note: If you click ID in the Match By group box, the synchronizer searches for a match first by 
ModelMart Object ID, then by ModelMart Object name.

Related Topics
    Using the ModelMart Synchronizer
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In the ModelMart Change Control Manager - Review Changes dialog, you can view the changes that the 
ModelMart Synchronizer must apply to the models in ModelMart in order to complete the 
synchronization. This dialog is similar to the standard ModelMart Change Control Manager. You can:

n Filter a change list 

n Cancel changes in a change list 

n Find items in a change list 

n View the currently selected search criteria 

n View information about a change statement in a change list 

n Generate a report on the change list information 

Related Topics
    Synchronizing BPwin and ERwin Models in ModelMart
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You can filter a change list in the ModelMart Change Control Manager using one or more of the following 
toolbar buttons:

n  Show Details. Click this button to display or hide detail-level changes.

n  Show Graphical Changes. This option is not applicable in the ModelMart Synchronizer.

n  Show Conflicts Only. This option is not applicable in the ModelMart Synchronizer.

Related Topics
    Reviewing the Model Changes Required for the Synchronization 



top-level change

A primary change to a BPwin model in Modelmart (such as, creating an activity) or an 
ERwin diagram in ModelMart (such as, creating an entity).



detail-level change

A change subordinate to a top-level change that is automatically applied to maintain 
the integrity of the model.
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In a change list, changes shown in black are changes that will be saved to the ModelMart when you save 
the model. Changes shown in red are changes that will not be saved to the ModelMart.

You can change the status (canceled or accepted) of each top-level change in the change list. When you 
change the status of a top-level change, the status of all related detail-level changes are changed 
accordingly. Changes that are not top-level changes are always unavailable (dimmed).

You can use SHIFT+click or CTRL+click to select multiple change items in a change list, then click the 
Toggle button  to change the status of all the items collectively. This feature is particularly useful when 
working with long change lists.

Related Topics
    To cancel changes in a change list
    Reviewing the Model Changes Required for the Synchronization 
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1. Review the change list and decide which changes you want to save or cancel.

2. Use one of the following methods to cancel the changes that you do not want to save to 
ModelMart:

n Double-click on a top-level change statement.

n Right-click on a top-level change statement and choose Toggle from the shortcut menu.

n Use SHIFT+click and CTRL+click to select multiple, top-level changes in the change list, then 
click the Toggle button .

When you apply the methods above, accepted changes (black) are canceled (red), and canceled 
changes (red) become accepted (black). If you change your mind, you can repeat the action above 
to reverse the change.

3. Click the Continue button . The changes marked in black are committed to the master model in 
ModelMart and the changes marked in red are discarded.
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The ModelMart Change Control Manager includes a search feature that you can use to quickly find 
information in a change list.

The find feature uses the fact that each change item has a format similar to that shown in the figure 
below. You can enter search criteria for one or more of the components of a change item.

When you click the Find in Script button  in the ModelMart Change Control Manager toolbar, the 
ModelMart Find in Script dialog is displayed. The ModelMart Find in Script dialog contains a number tabs 
in which you can specify search conditions for the various components of a change statement in a 
change list. Each tab corresponds with one of the change item components identified in the figure above.

By specifying search criteria in many different tabs, you can customize your search criteria to find the 
most specific list of items in the change list. When you start the search, all change statements that match 
the search criteria are marked found by the match symbol ( ).

You can click the Find First or Find All buttons to begin the search. If you click the Find First button, the 
name of the button changes to Find Next after the first match so that you can search for subsequent 
match items.

There are also two generic options in the ModelMart Find in Script dialog:

n Hide Unmatched. Select this check box to hide all items that do not match the search criteria. 
When you select this option, you must use the Find All button. The Find First button is unavailable 
(dimmed) in this context.

n Select Matched. Select this check box to have matched items selected (highlighted). If you click 
the Find All button with this option selected, all matched items are highlighted. This option is useful 
if you want to toggle a set of related change statements.

Related Topics
    Specifying Search Criteria for a Change Statement Component
    Reviewing the Model Changes Required for the Synchronization 
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You can specify search conditions for a specific change statement component in the corresponding tab 
in the ModelMart Find in Script dialog:

n Type. Select the types of change that you want to find in the current change list. For example, find 
all change statements with the Create type.

n Class. Select the classes that you want to find in the current change list. For example, find all 
change statements that apply to the Entity class.

n Object. Select the objects that you want to find in the current change list. For example, find all 
change statements that apply to the Customer.number object.

n Property. Select the properties that you want to find in the current change list. For example, find all 
change statements that include the BPwin index property.

Each tab contains the following controls which you use to set the search criteria:

n List of possible change statements. This list shows the items you can search for in the current 
change list. For example, the Class tab shows a list of all classes referenced in the change list. You 
can select a class, or multiple classes (using SHIFT+click or CTRL+click) to find items in the 
change list that reference one of the selected classes.

n Find non-matches. Select this box to find items in the change list that match one of the unselected 
items in the list above. In the Filter dialog, this condition is identified by the letters NE which stands 
for “not equal to”.

n Cancel. Click this button to clear all items selected in the list above.

Note: An asterisk (*) is displayed next to the tab label when the tab contributes to the current search 
criteria. When you click the Cancel button, the asterisk next to the tab label is removed indicating 
that it no longer contributes to the search criteria.

Related Topics
    To find an item in a change list
    Reviewing the Model Changes Required for the Synchronization 
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1. Click the Find in Script button .

2. Choose one or more of the following:

n To search for one or more change statements of a specific type, for example Create, click the 
Type tab, then select one or more of the types you want to find in the Type list box.

n To search for one or more change statements that apply to a specific class, for example Entity, 
click the Class tab, then select one or more of the classes you want to find in the Classes list 
box.

n To search for one or more change statements that apply to a specific object, for example the 
STORE.store-id object, click the Object tab, then select one or more object from the Object list 
box.

n To search for one or more change statements that apply to a specific property, for example the 
‘Rectangle’ feature property, click the Property tab, then select one or more properties in the 
Property list box.

3. Choose one of the following:

n To find the first item in the change list that matches the criteria you have specified in the tabs, 
click the Find First button. The button name changes to Find Next after the first change 
statement match.

n To find and mark all the items in the change list that match the criteria you have specified in the 
tabs, click the Find All button.

Matched items are marked with the match symbol ( ) which is displayed to the left of the change 
statement in the change list.

Note: In Step 2 above, on each tab you can select the Find Non-matches check box to search for the 
unselected items in the list box on the respective tab.
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Once you specify the search conditions, you can use the Filter Text  button to view the currently 
selected search conditions in the Filter dialog. 

Each line in the filter dialog corresponds to a search condition defined on one of the tabs in the 
ModelMart Find in Script dialog.

If you change any of the search conditions while the Filter dialog is displayed, the Filter dialog is 
automatically updated.

If your search includes more than one component, the letters OR appear between the components in the 
Filter dialog. If you select the Find non-matches check box in a tab, the letters NE denoting “not equal to” 
appear next to the selected component in the line corresponding to that tab.

Related Topics
    To view the currently selected search criteria
    Reviewing the Model Changes Required for the Synchronization 
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n Click the Filter Text button  on the ModelMart Change Control Manager toolbar. ModelMart 
opens the Filter dialog which shows the currently selected search criteria.

Note: In the Filter dialog, OR denotes search criteria including more than one change component. NE 
denotes “not equal to” meaning that the search includes all components except the component 
labeled NE.
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In a single-panel change list, when you right-click on a change statement and choose More Information 
from the shortcut menu, the ModelMart Change Information dialog shows a two-column list:

n The first column shows the properties of the change statement. 

n The second column shows the value of each property. 

Click here for an example.

While the ModelMart Change Information dialog is displayed, you can click any change in the Change 
List and the ModelMart Change Information dialog is updated to reflect the selected change.

If the change item you select is a detailed-level change, a Parents property is displayed in the property 
list. The value of the Parent property is a hot link to the change that caused the detail-level change. 
Similarly, if the change item you select is a top-level change that causes other changes in the change 
list, a Children property is displayed in the property list. The value of the Children property is one or more 
hot links to related child change statements.

Note: To display information about an item in a change list, you can also click on the change item to 
select it, then click the Open Info Window button  on the ModelMart Change Control Manager 
toolbar.

Related Topics
    To view information about a change in a change list
    Reviewing the Model Changes Required for the Synchronization 
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n Choose one of the following:

n Select the change statement, then click the Open Info Window button .

n Right-click on the change statement and choose More Information from the shortcut menu.
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While reviewing the changes required for synchronization you can click the Save Local  button      on 
the ModelMart Change Control Manager Toolbar to save a local copy of the ERwin or BPwin model 
being updated by the synchronization. In this way, you can review the effect of the synchronization 
changes without saving them to the ModelMart. At a later time, you can merge the changes in your local 
copy of the model back into the master model in the ModelMart.

Related Topics
    To save a local copy of a model that includes synchronization changes
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1. Click the  on the ModelMart Change Control Manager toolbar or choose Save Local from the 
File menu. The appropriate Save As dialog is displayed.

2. Select a directory and type a name for the new model file.

3. Click OK.
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In the ModelMart Change Control Manager, you can open the Report Browser to generate reports on the 
ModelMart model changes shown in the change list.

When you click the Report Browser button  in the ModelMart Change Control Manager toolbar, the 
Report Browser opens and displays a Script Reports folder in the tree control. The Script Reports folder 
contains two reports:

n Script. A report on the top-level changes shown in the change list.

n Script with Details. A report on the top-level and detail-level changes in the change list.

Double-click on a report to generate a results set.

Related Topics
    To create a ModelMart Change Control Manager report
    Sample ModelMart Change Control Manager Report
    ModelMart Change Control Manager Report Content



To create a ModelMart Change Control Manager report {ewc 
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1. Click the Report Browser button  in the ModelMart Change Control Manager toolbar.

2. In the Report Browser tree control, open the Script Reports folder.

3. Choose one of the following

n Double-click on the Script report to get a result set with information about the top-level 
changes in the change list.

n Double-click on the Script with Details report to get a result set with information about top-
level and detail-level changes in the change list.

4. Use the Report Browser’s extensive range of features to format, print, export, or find information in 
the result set. See Customizing a Result Set View   for more information.
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The content of all ModelMart Change Control Manager reports is similar. The following columns are 
displayed in a result set generated by a ModelMart Change Control Manager report:

n Operation. The operation that characterizes the change, such as create, update, delete and so on.

n Class. The class of the object being changed.

n Object. The name of the object being changed.

n Property. The property of the object being changed.

n Value. The value to which the property is being changed.

n Cancelled. A flag that indicates that a change is cancelled (displayed in red text) in the change 
list).

n Prohibited. A flag that indicates a change is prohibited, typically because the user making the 
change does not have the required permissions in their ModelMart security profile.

The following columns are also included in the result set, but are hidden in the default report format:

n Class Id. The ModelMart Id of the class of the object being changed.

n Object Id. The ModelMart Id of the object being changed.

n Object Name. The ModelMart name of the object being changed.

You can easily make these columns visible. See Specifying Column Options for a Result Set for more 
information.

Related Topics
    Sample ModelMart Change Control Manager Report



Sample ModelMart Change Control Manager Report {ewc 
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The report shown below is an example of a ModelMart Change Control Manager report.

Related Topics
    ModelMart Change Control Manager Report Content



Exiting the ModelMart Change Control Manager {ewc 
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You can click the Cancel button  on the ModelMart Change Control Manger toolbar to exit the 
ModelMart Change Control Manager. When you choose this option, none of the changes in the change 
list are saved to the master model in ModelMart. However, your copy of the BPwin model in 
ModelMart, remains open.



Creating a ModelMart Security Manager Report {ewc 
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When you click the Report button in the ModelMart Security Manager dialog, the Report Browser opens. 
The tree control in the Report Browser displays a Security Reports folder that contains one predefined 
Security Report. When you double-click on the Security Report icon in the tree control, the Report 
Browser generates the result set that provides information about the security profiles assigned to each 
ModelMart user and the permissions associated with those profiles. 

After you generate the report, you can use the Report Browser features to customize the appearance of 
a result set, find one or more specific items in the result set, print the result set, or export the result set. 
See Customizing a Result Set View   for more information.

Note: You can also generate a report on changes you have made using the ModelMart Security 
Manager. See Creating a ModelMart Change Control Manager Report for more information.

Related Topics
    ModelMart Security Manager Report Information
    To create a ModelMart Security Manager Report
    Sample ModelMart Security Manager Report



To create a ModelMart Security Manager Report {ewc 
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1. In the ModelMart Security Manager dialog, click the Report button. The Report Browser opens.

2. In the Report Browser tree control, open the Security Reports folder.

3. Double-click on the Security Report icon. The Report Browser generates a result set that contains 
information about the security profile assigned to each ModelMart user and the permissions 
granted by each secuirty profile.

Related Topics
    Sample ModelMart Security Manager Report
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The standard Security Report generates a result set with the following information:

n User Name. The name of the ModelMart user. For example, JSMITH.

n Object Class Name. The class of the object. For a ModelMart Security Manager Report, this is 
always ModelMart.

n Object Name. The name of the object. For example, Current ModelMart.

n Profile Name. The security profile name. For example, Architect.

n Profile Description. A description of the security profile. For example, A profile assigned to a lead 
modeler.

n Permission Type Name. The name of the permission in a security profile. For example, Create 
Diagram.

n Granted. The permission status; 1 indicates the permission is granted, blank indicates the 
permission is not granted.

Related Topics
    Sample ModelMart Secuirty Manager Report
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The report shown below is an example of a ModelMart Security Manager report.

Related Topics
    ModelMart Security Manager Report Information



Report Browser

Click this button on the toolbar to open the Report Browser.
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The main Report Browser window is divided into six areas as follows:

n Menu Bar. Contains menus for accessing Report Browser functions. See Report Browser Menu 
Options and Toolbar Controls   for more information.

n Toolbar. Contains a number of buttons and a list for the currently selected result set. This list 
displays the twenty most recently generated reports or report views. See Report Browser Menu 
Options and Toolbar Controls   for more information.

n Tree Control. Shows the various reports and corresponding result sets in a hierarchical structure. 
The caption bar above the tree control shows the currently selected root node of the tree. See Tree 
Control  for more information.

n Result Set Area. Displays the actual result set generated by a report. The caption bar above the 
result set area displays information about the currently displayed result set.

n Description Area. Shows a description of the currently selected report or customized report view. 
For ERwin reports, the description in this area is the same as the description you enter on the 
Definition Tab of the ERwin Report Editor when you are creating or editing an ERwin report. 

n Tree Control Toolbar. Contains four buttons for managing the items in the tree control. See 
Navigating and Managing the Tree Control   for more information. 

Related Topics
    Report Browser Menu Options and Toolbar Controls
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The menu bar and toolbars in the main Report Browser window provide the controls you can use to 
generate and work with reports. When you position the cursor over a toolbar button, ToolTip text 
explaining the function of the toolbar button displays.

You can use the Tree Control Toolbar, located below the Description area to customize your view of the 
tree, delete items in the tree control, or edit ERwin reports.

Related Topics
    Summary of Report Browser Menu Options and Toolbar Controls
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The table below briefly explains the purpose of each Report Browser menu option, identifies the 
corresponding toolbar control, and explains where to get more information. Not every menu option has a 
corresponding toolbar control and vice-versa.

Menu Option Toolbar Control Use this option or control to:

File New ERwin 
Report

Create a new ERwin report or a new folder.

File New Folder Create a new report folder. See To create a new 
report folder  for more information.

File Save View Save a customized view of a report. See Saving a 
Report View  for more information.

File Execute Report Generate the selected report.

File Save Changes Save changes to a cell in an editable report.

Most recently generated reports 
list.

Displays the name of the currently selected report 
or report view. You can choose one of the 20 most 
recently generated reports or report views, then 
click the execute report button to generate it.

File Print Print the selected result set. See Printing a Result 
Set  for more information.

File Print Preview Preview a result set before printing. See 
Previewing a Result Set  for more information.

File Export Export a result set in CSV or HTML format or 
export to RPTwin, or to an application that supports 
DDE. See Exporting a Result Set   for more 
information.

File Exit Exit the Report Browser.

Edit Report Format Specify the column and sort options for a result set. 
See Specifying Column Options for a Result Set   
and Specifying Column Sort Order and Sort Type   
for more information.

Edit the selected ERwin report.

Edit Icons Assign icons to values in a result set. See 
Assigning an Icon to a Result Set Value   for more 
information.

Edit Copy Copy the current result set to the Windows 
Clipboard.

Edit Paste Paste text from the Clipboard into a cell in an 
editable report.

Edit Delete Delete the selected report, report format, or empty 
report folder.

Search Find Specify search conditions for the current result set 
and find the rows that satisfy them. See Finding 
Items in a Result Set   for more information.

Find the next row in the result set that satisfies the 
current search conditions. See Finding Items in a 
Result Set  for more information.

Search Available Reports Show the reports available to the selected result 
set row. See Using a Result Set Row to Generate a 
Report  for more information.

View Folders Display/Hide the tree control.



View Reports by 
Category

Display the reports by category. When you choose 
this item, the General folder becomes the root node 
of the tree control. The ModelMart <NAME> folder 
is hidden. See Using the Report Browser with 
ModelMart  for more information.

View Reports by 
ModelMart Object

Display the reports by ModelMart object. When you 
choose this item, the ModelMart <NAME> folder 
becomes the root node of the tree control. The 
General folder is hidden. See Using the Report 
Browser with ModelMart   for more information.

View History Display all the result sets generated during the 
current ERwin and ModelMart sessions, in 
chronological order. See To display a history of 
generated result sets  for more information.

Display the result set that supplied the parameter 
values used to generate the currently displayed 
result set. See Using a Result Set Row to Generate 
a Report  for more information.

ERwin 
Reports

New Report File Create a new ERwin Reports (.erp) file that does 
not include any existing ERwin Reports.

ERwin 
Reports

Open Report File Open a different ERwin Reports (.erp) file.

ERwin 
Reports

Save Report File 
As

Save your ERwin reports to a new ERwin Reports 
(.erp) file.

ERwin 
Reports

Copy Report to 
ModelMart

Save the currently selected report in ModelMart as 
a shared ERwin report so that it is available to all 
ModelMart users.

ERwin 
Reports

Copy Report to 
Local File

Save the currently selected shared ERwin report in 
the ERwin Reports (.erp) file.

Help About Report 
Browser

Display general information about the Report 
Browser.

Collapse the tree to show only the top-level folders. 
See To collapse all open folders in the tree control   
for more information.

Make the selected folder the root of the tree. See 
To make the selected folder the root node   for more 
information.

Make the parent folder of the selected folder the 
root of the tree. See To move the root node up one 
level  for more information.

Tree Control {ewc HLP25632,HLP256_TILE,water.bmp}

The tree control displays the Report Browser reports and result sets as an indented outline based on 
their logical hierarchical relationship. The caption bar above the tree control shows the currently selected 
root node of the tree.



When you are using ERwin without a ModelMart connection, the tree control shows one node called 
ERwin Reports <ERP filename>. This is the base node for a hierarchy of folders containing existing 
ERwin reports, customized report views, and result sets. When you click the expand symbol  next to 
the ERwin Reports node, it expands to show folders of predefined reports organized by category. The 
Report Browser shows a folder for each report category in which one or more reports exist. Click the 
expand symbol next to a report category folder to view the reports in that category.

The meaning of each tree control symbol is shown below:

n  Report Folder

n  Report

n  Editable Report

n  Result Set

n  Report View

Related Topics
    Shortcut Menus for Tree Control Objects
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The Report Browser provides shortcut menus for the objects displayed in the tree control. The table 
following shows the shortcut menu options for each object type:

Object Type Shortcut Menu Options Function

Folder ( )
(user created 
folders only)

Rename ‘<folder name>’ Enables you to edit the <folder name>.

Report ( ) or 
Editable Report (
)

Edit ERwin Report ‘<report name>’ Opens the ERwin Report Editor dialog.

Execute Report ‘<report name>’ Run the selected report.

Rename ‘<report name>’ Enables you to edit the selected <report 
name>.

Result set ( ) Edit report format for ‘<report name>’ Opens the Report Format dialog.

Print result set ‘<result set name>’ Sends the selected result set to a local 
printer.

Preview result set ‘<result set name>’ Opens the Print Preview dialog.

Rename ‘<result set name>’ Enables you to edit the selected <result 
set name>

View ( ) Execute report ‘<report view name>’ Generate a report in a format defined by 
the view.

Rename ‘<report view name>’ Enables you to edit the selected <report 
view name>

Related Topics
    Navigating and Managing the Tree Control
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You can customize what you see in the tree control using a variety of controls and toolbar buttons. You 
can:

n Expand ( ) or collapse (
) each folder.

n Collapse all open folders.

n Make any folder the root node of the tree control.

n Move the root up one level, that is, make the parent of the current root the new root of the tree. The 
Make Parent Folder the Root button  is not available (dimmed) when the complete tree is visible 
(that is, when the tree control caption is "All reports").

n Create a new report folder.

n Delete a report ( ), a customized report view (
), a result set (
), or an empty report folder (
).

The tree control toolbar below the description area in the main window contains a number of buttons to 
help you manage the items in the tree control. See Summary of Menu Options and Toolbar Controls   for 
more information.

Related Topics
    Shortcut Menus for Tree Control Objects
    To display all report folders
    To collapse all open folders in the tree control
    To make the selected folder the root node
    To move the root node up one level
    To create a new report folder
    To delete an item from the tree control
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n Click the  button until the button is dimmed.

Note: You do not have to select the current root before you click the  button.



To collapse all open folders in the tree control {ewc 
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n Click the  button. The tree control shows only the first level of folders.



To make the selected folder the root node {ewc HLP25632,HLP256_TILE,water.bmp}

1. Click on the folder in the tree control that you want to make the root node.

2. Click the  button. The folder you selected becomes the root node.
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n Click the  button. The parent folder of the currently selected root node becomes the new root 
node of the tree.
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1. Click on the folder where you want to insert the new folder.

n If you want the new folder to be at the same level as the selected folder, make sure the 
selected folder is collapsed, that is, has a  symbol next to it.

n If you want the new folder to be a child of the selected folder, click on the  symbol next the 
selected folder to expand it.

2. Choose New Folder on the File menu. The Report Browser adds a new folder to the tree control. 
By default, the folder is assigned the name New Folder.

3. Type a new name and press ENTER.
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1. Click on the item in the tree control that you want to delete.

2. Click the  button. The selected item is deleted.

Note: A folder must be empty before you can delete it.

You cannot delete a ModelMart object.

You can delete a predefined report in the General or ModelMart <Name> folder to remove it from 
the tree control, but it remains in the ModelMart and other users can access it when they open 
the Report Browser.
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You can display a list of all the result sets generated in the current ERwin and ModelMart sessions in 
chronological order. When you choose History on the View menu, or click the Display browser history 
button , the Report Browser open the Result set History dialog so that you can choose to display or 
delete one or more of the result sets generated during the current ERwin or ModelMart session.

When you double-click on a result set in the History dialog, the result set is displayed in the Result set 
area and the icon for that result set is highlighted in the tree control. This is an easy way to locate the 
result set icon that corresponds to a result set.

The purpose of each control in the Result Set History dialog is explained below:

n Result set list. Lists the result sets generated during the current ERwin and Modelmart sessions in 
chronological order.

n Display. Displays the result set selected in the result set list.

n Delete. Deletes the result set selected in the result set list.

n Close. Closes the dialog.

Related Topics
    To display a history of generated result sets
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1. Click the  button or choose History on the View menu to open the Result Set History dialog.

2. Select the result set you want to view.

3. Choose one or more of the following options:

n To view the result set in the Browser, click the Display button. The Report Browser displays the 
selected result set and selects the result set icon in the tree control.

n To delete the result set, click the Delete button.

4. Click the Close button to close the Result Set History dialog.
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You can change the formatting of the result set displayed in the Browser, including:

n The order in which columns are displayed.

n The appearance of each column (visible or hidden, bold, grayed).

n The column headings.

n The order in which the rows are displayed.

n Whether or not certain rows are displayed. See Finding Items in a Result Set   for more information.

n The icons associated with report values. See Assigning an Icon to a Result Set Value   for more 
information.

Once you have made your changes and you are satisfied with the way the results are presented, you 
can save them in a named report view. The report view ( ) appears in the tree control, and you can 
generate it just like a predefined report. This means that the work of developing an effective presentation 
needs to be done only once. A single report can have many views, and you can switch between views 
without regenerating your result set. See Saving a Report View  for more information.

Related Topics
    Specifying Column Options for a Result Set
    Specifying Column Sort Order and Sort Type
    Assigning an Icon to a Result Set Value
    Finding Items in a Result Set
    Hiding Rows That Do Not Match the Search Criteria
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When you choose Report Format on the Edit menu, or click the  button in the toolbar, the Report 
Browser displays the column and sort options dialog. Using the controls in the Column Options tab, you 
can customize your view of the result set to:

n Select only the columns that you want in the result set.

n Change the order of columns in the result set.

n Change the appearance of the columns in a result set.

n Change the heading for a result set.

The purpose of each control in the Column Options tab is explained below:

n Column. Displays the columns in the selected report. Select the check box next to each column 
you want to include in the result set. Clear the check box next to each item you do not want to 
appear in the report. The option selected in the Option list described below determines the display 
characteristics of the selected columns in the Columns list.

n Move Up. Click this button to move the currently selected column up one place in the Column list.

n Move Down. Click this button to move the currently selected column down one place in the 
Column list.

n Heading. Click this button to open the Column Heading dialog. You can edit the column heading 
for the currently selected column.

n Option. Select a column display option, then select the check box next to each column in the 
Column list to which you want to apply the option. The options are:

n Visible. Select the check box next to each column in the list that you want to be displayed. 
Clear the check box next to the columns you want hidden.

n Popup. Select to display the content of a column in a popup box.

n Bold. Select the check box next to each column in the list that you want to be bold.

n Grayed. Select the check box next to each column in the list that you want to be grayed.

Related Topics
    To select the columns to include in the result set
    To change the order of columns in a result set
    To change the appearance of one or more columns in a result set
    To change a column heading in a result set
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1. Double-click on a report to display the result set.

2. Click the  button in the toolbar or choose Report Format on the Edit menu to open the column 
and sort options dialog.

3. Click on the Column Options tab if not already selected.

4. Choose the Visible option in the Option list.

5. Select the check box next to each column that you want to appear in the result set.

6. Click OK. The Report Browser redisplays the result set, which now contains only the columns you 
specified.



To change the order of columns in a result set {ewc 
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1. Double-click on a report to display the result set.

2. Click the  button in the toolbar or choose Report Format on the Edit menu to open the column 
and sort options dialog.

3. Click on the Column Options tab, if not already selected.

4. Click on a column, then click the Move Up or Move Down buttons to move the column to the 
position you want in the result set view.

5. Repeat Step 3 above for other columns until you get the column order you want in the result set 
view.

6. Click OK. The Report Browser redisplays the result set with the columns in the order you specified.



To change the appearance of one or more columns in a result set {ewc 
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1. Double-click on a report to display the result set.

2. Click the  button in the toolbar or choose Report Format on the Edit menu to open the column 
and sort options dialog.

3. Click the Column Options tab.

4. Select the column display option in the Option list (for example, Bold).

5. Select the check box next to each column to which you want to apply the column display option. 
Clear the check box next to each column to remove the display option from that column.

6. Optionally, repeat Steps 3 and 4 to apply another column display option to a column (for example, 
Grayed).

7. Click OK. The Report Browser redisplays the result set which shows the columns with the new 
column display options applied.
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1. Double-click on a report to display the result set.

2. Click the  button in the toolbar or choose Report Format on the Edit menu to open the column 
and sort options dialog.

3. Click the Column Options.

4. Click the column name that you want to change.

5. Click the Heading button to open the Column Heading dialog.

5. Type the heading that you want to assign to the result set column in the Column Heading box.

6. Click OK. The Report Browser displays the result set with the column heading you assigned.
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When you choose Report Format on the Edit menu or click the Options button  in the toolbar, the 
Report Browser displays the column and sort options dialog. Using the controls in the Sort tab, you can 
customize your view of the result set by:

n Sorting the result set on a specific column and changing the sort type (ascending or descending) 
for that column.

n Sorting on more than one column.

n Changing the order of the sorted columns.

The purpose of each control in the Sort tab is explained below:

n Columns. Select the check box next to each column that you want to sort in the result set rows. 
The columns you select are placed in the Sort Columns list.

n Sort Columns. Shows the columns in the result set rows that are sorted, the sort type (ascending 
 or descending 

) for each column, and the order in which column sorting is done when sorting on more than one 
column. The first column in the list is sorted first, the second column is sorted second, and so on.

n Move Up. Click this button to move the selected column up one place in the Column Sort list.

n Move Down. Click this button to move the selected column down one place in the Sort Columns 
list.

n Ascending. Click this button to sort the selected column in ascending order.

n Descending. Click this button to sort the selected column in descending order.

Related Topics
    To sort a result set on one or more columns
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1. Double-click on a report to display the result set.

2. Click the  button in the toolbar or choose Report Format on the Edit menu to open the column 
and sort options dialog.

3. Click on the Sort tab.

4. Select the check box next to the column in the Columns list box that you want to sort in the result 
set. The Report Browser displays the column you select in the Sort Columns list. By default, each 
new sort column is automatically assigned an ascending order sort type indicated by the  symbol 
next to the column.

5. Repeat Step 4 for each column that you want to sort on.

6. Optionally, select a column in the Sort Columns list and click the order type button (ascending  or 
descending 

) to change the sort order type for the selected column.

7. Repeat Step 6 for each column that you want to sort on.

8. Click OK. The Report Browser displays the result set with the sort order you specified.

Note: You can sort on any column in the result set regardless of whether it is displayed or not. A sort 
column can contain any type of data (that is, numbers, strings, or dates). String sorting is 
independent of case.
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You can assign an icon to a result set value so that each occurrence of the value is easily identifiable in 
a result set. The Report Browser provides a set of predefined icons for this purpose. You can also 
specify the position of the icon relative to the value (that is, to the left, to the right, or centered).

When you choose Icons on the Edit menu, or click the  button on the toolbar, the Report Browser 
opens the Icons dialog.

The purpose of each control in the Icons dialog is explained below:

n Icons. Displays a list of the icons that you can assign to a result set value. You can drag an icon 
from this list directly onto a result set value to assign the icon to the value. Assign the blank space 
at the top of the list to remove an icon from a result set value.

n Style. Specify the icon positioning option (that is, the position of an icon relative to the result set 
value). The options are:

n Icon left of value

n Icon right of value

n Icon replaces value

n OK. Closes the dialog and saves your changes.

n Cancel. Closes the dialog and cancels any changes.

Icons enhance your view of a result set and you can incorporate them into a report view. When you 
assign an icon to a result set value, you can quickly identify that value in the result set.

Related Topics
    To assign an icon to a result set value
    To remove an icon from a result set value
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1. Double-click on a report to display the result set.

2. Click the  button in the toolbar or choose Icons on the Edit menu to open the Icons dialog.

3. Select the icon positioning option you want in the Style box.

4. Drag the icon you want from the Icons list to a value in the currently displayed result set. The 
Report Browser assigns the icon you selected to each occurrence of the value in the result set.

Note: To change the icon assigned to a value, drag the new icon to the value in the result set.
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1. Double-click on a report to display the result set.

2. Click the  button in the toolbar or choose Icons on the Edit menu to open the Icons dialog.

3. Drag the blank icon (the first icon in the list) to a value in the result set that contains the icon you 
want to remove. The Report Browser removes the icon you selected for each occurrence of the 
value in the result set.
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The Report Browser includes a search tool that you can use to quickly find information in a result set.

When you choose Find on the Search menu, or click on the  button in the toolbar, the Report Browser 
displays the Find in Result Set dialog which provides several options for customizing your search. You 
can:

n Find and mark the first row in the result set that satisfies your search conditions.

n Find and mark all rows in the result set that satisfy your search conditions.

n Hide all the rows in the result set that fail to satisfy your search conditions.

n Display your result set in outline and detail form.

n Find and mark the rows in the result set where the value in a column changes from the previous 
value.

Each control in the Find in Result Set dialog is explained below:

n Column. Displays a list of the columns that you can search on. A binocular symbol  is displayed 
next to the column if there is a search expression defined for that column. To clear the search 
expression for a column, select the column, then click the Clear button.

n Expression. Enter the search criteria for the selected column. Use the text below the box for 
guidelines on the permitted expression syntax.

n Find First. Finds the first row in the result set that satisfies the search expressions you have 
defined for result set columns and places the match symbol ( ) next to it in the result set. You can 
use the Find Next button 

 in the toolbar to find subsequent matches in the result set. This option is useful when the result set is 
large and a complete search on all of the rows takes some time.

n Find All. Finds all the rows that satisfy the search expressions you have defined for the result set 
columns and places the match symbol ( ) next to them in the result set. When you click the Find 
All button, the Find dialog closes automatically.

n Clear. Click this button to clear all settings in the dialog before specifying new search conditions.

n Cancel. Closes the dialog and cancels any changes.

n Hide Unmatched. Select this check box to hide the result set rows that fail to satisfy the search 
criteria. When you select this check box, the match symbol ( ) is not displayed in the returned 
result set because all rows match the search criteria.

n Collapse/Expand. Select this check box to display the result set in outline and detail form. When 
you select this check box, the Report Browser hides unmatched items but gives you the option to 
view them. An expand symbol  is displayed next to each matched item. You can click the 

 symbol to see all unmatched items up to the next matched item. When a matched item is expanded, a 
collapse symbol 

 is displayed next to the matched item. You can click the 
 symbol to hide all the unmatched items between the matched item and the next matched item.

n Find Value Changes. Select this check box to find the rows where the value of the selected 
column changes. This option is useful when searching columns that many repeating values.

Related Topics
    To find result set rows that match the specified search criteria
    To find a change of value in a result set column
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1. Double-click on a report to display the result set.

2. Click the  button on the toolbar or choose Find on the Search menu to open the Find In Result 
Set dialog.

3. Select the column on which you want to search.

4. Type the search criteria in the Expression box. Use the text below the box as a guideline for the 
permitted expression syntax. After you specify an expression, ERwin places a binocular symbol  
next to the column in the list.

5. Optionally, repeat Steps 2 and 3 to define search expressions on other columns.

6. Choose one or more of the following options:

n To find the first result set row that satisfies all of the search expressions you have defined for 
selected columns, click the Find First button. The Report Browser displays a match symbol (
) next to the first row where the column values match the search expressions.

n To find the next result set row that satisfies the search expressions defined for the selected 
columns, click the  button on the toolbar.

n To find and mark all result set rows that satisfy the search expressions defined for the selected 
columns, click the Find All button in the Find In Result Set dialog. The Report Browser 
displays a match symbol ( ) next to all rows where the column values match the search 
expressions.

Note: To clear the search expression for a column, first select the column, then click the Clear button.
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1. Double-click on a report to display the result set.

2. Click the  button on the toolbar or choose Find on the Search menu to open the Find In Result 
Set dialog.

3. Select the column in which you want to find a value change.

4. Select the Find Value Changes check box.

5. Click the Find First button. The Report Browser displays a match symbol ( ) next to the first row 
where the selected column value changes.

6. Choose one or more of the following options:

n To find the next change of value in the selected column, click the  button on the toolbar.

n To find and mark all rows where the selected column value changes, click the Find All button in 
the Find In Result Set dialog. The Report Browser displays a match symbol ( ) next all rows 
where the column value changes.
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When you specify a search criteria in the Find In Result Set dialog, you can choose to hide the rows that 
do not match the search criteria. In addition, you can use the expand and collapse feature to produce a 
search result set in which you can expand (view) or collapse (hide) the rows that do not satisfy the 
search criteria.

Related Topics
    To hide result set rows that do not match search criteria
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1. Double-click on a report to display the result set.

2. Click the  button on the toolbar or choose Find on the Search menu to open the Find In Result 
Set dialog.

3. Select the column on which you want to search.

4. Type the search criteria in the Expression box. Use the text below the box as a guideline for the 
permitted expression syntax. A check is displayed in the box next to the column in the list.

5. Optionally, repeat Steps 2 and 3 to define search expressions on other columns that you want your 
search to satisfy.

6. Select the Hide Unmatched check box.

7. Optionally, select the Expand/Collapse check box.

8. Click the Find All button. The Report Browser displays only rows that match the search criteria. If 
you selected the Expand/Collapse check box in Step 7, a  symbol is displayed next to each 
matched value. Click the 

 symbol to view the unmatched values.
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After you make formatting changes to your result set, you can save them as a named report view, which 
functions exactly like a predefined report. The report view ( ) appears in the tree control under the 
report (

) or the editable report (
) on which it is defined, and you can generate it by double-clicking it, just like a normal report. Report 

views are also displayed in the Most-Recently Used list in the toolbar and in the Available Reports display 
for a result set row. You can even drop a result set row on an eligible report view to run the report.

A report view includes all result set format changes, including column ordering, heading changes, sorting 
options, icon assignments, and search criteria. You can define several report views for the same report. 
You can even switch between report views for the same result set without re-generating the report, 
simply by dragging the result set icon and dropping it on the report view you want to see.

When you choose Save View on the File menu, or click the Save View button  on the toolbar, the 
Report Browser opens the Save View dialog. You can also click the Save button in the Report Options 
dialog to open the Save View dialog.

The purpose of each control in the Save View dialog is explained below:

n View Name. Enter a name for the report view. You can also select an existing report view name if 
you want to overwrite that view with the current view settings.

n Parameters. If the result set for which you are defining the report view was generated by a report 
requiring parameters, the Report Browser gives you the option of saving the parameter values as 
part of the report view. Select the check box next to each parameter for which you want to include a 
value as part of the report view. 

For example, if the result set was generated by an Entities report for the Human Resources Model 
diagram, then this list contains one item, the object identifier for the Human Resources Model 
diagram.

n If you select the check box next to this item, the identifier becomes part of the report view, 
which means that the next time you generate the report view, it produces a list of entities in the 
Human Resources Model diagram.

n If you do not select the check box next to this item, the identifier does not become part of the 
report view, which means that you can generate it for any diagram and it appears in the 
Available Reports dialog for any result set row that identifies a diagram.

n Description. Enter a description of the report view. The description you enter appears in the box 
below the tree control when you select the report view in the tree control.

n OK. Closes the dialog and saves your changes.

n Cancel. Closes the dialog and cancels any changes.

Related Topics
    To save a report view



To save a report view {ewc HLP25632,HLP256_TILE,water.bmp}

1. Double-click on a report to display the result set.

2. Customize the report format. More>

3. Click the  button in the toolbar or choose Save View on the File menu to open the Save Report 
View dialog.

4. Click in the Report View Name box and type a name for the report view.

5. Optionally, if you want to include one or more parameters as part of the report view, select the 
check box next to each parameter you want to include.

6. Optionally, enter a description of the report view in the Description text box.

7. Click OK. The Report Browser saves the report view with the name you specify and adds a report 
view icon ( ) to the tree control under the report from which the view was generated.
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The Report Browser provides many different options for printing a result set in the format you want. 
When you choose Print on the Report Browser File menu, the Report Browser opens the Print Result Set 
dialog.

Using the Print Result Set dialog, you can: 

n Set options for printing the result set.

n Specify the page setup for the result set printout . 

n Preview the result set before printing. 

n Export the result set. 

Related Topics
    To print a result set
    To set print and page layout options
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n Choose any one of the following:

n Click the Print button on the Report Browser toolbar to open the Print Result Set dialog. 
More>>

n Right-click on a result set in the tree control and choose Print result set ‘<result set name>’ 
from the shortcut menu
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1. Click the Print button on the Report Browser toolbar to open the Print Result Set dialog.

2. Select the print options you want in the Print range, Print what, Copies, Presentation, and On 
line overflow group boxes. More>> 

3. Optionally, click the Page Setup button and select the page setup options you want. More>> 

4. Optionally, click the Print Preview button to preview the result set printout before printing. More>> 

5. Optionally, click the Printer button to open the standard Windows Print Setup dialog.

6. Click OK.
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When you choose Print on the Report Browser File menu, the Report Browser opens the Print Result Set 
dialog. Using the options in the Print Result Set dialog, you can select the page range, the area of the 
result set to be printed, the number of copies, the output format, and the page width overflow options.

The purpose of each control in the Print range group box is explained below:

n All. Print all pages in the result set.

n Page(s). Print the range of pages specified in the From and To boxes.

n From. Type the starting page of a page range.

n To. Type the ending page of a page range.

The purpose of each control in the Print what group box is explained below:

n Selection. Print only the selected area of the result set.

n Entire result set. Print the complete result set.

The purpose of each control in the Copies group box is explained below:

n Copies. Type the number of copies you want to print.

n Collate. Select this check box to collate pages.

The purpose of each control in the Presentation group box is explained below:

n Tabular. Print the result set in a format similar to how the result set is displayed on screen. Click 
here for an example.

n Master-detail. Print the result set in a format that uses a combination of headings and tables. The 
Report Browser uses the relationship between model components to determine which values are 
printed in headings and which values are printed in tables. Click here for an example.

n Indented. Print the result set as an indented list. The Report Browser uses the relationship 
between model components to determine which values are indented and which values are not 
indented. Click here for an example.

n One Item per line. Print a result set with one item on each line. Click here for an example.

The purpose of each control in the On line overflow group box is explained below:

n Span. Print a result set where the width of the result set spans horizontally across pages when 
necessary.

n Wrap. Print a result set where columns that do not fit in the width of the page are wrapped to the 
next available space in the result set output.

n Repeat. Type the number of columns that are repeated when result set columns are wrapped.

Related Topics
    Specifying the Page Setup for a Result Set Printout
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When you click the Page Setup button on the Print Result Set dialog, the Report Browser displays the 
Page Setup dialog that contains three tabs:

n Layout. Use this tab to set the style of the grid lines, the size of each margin, the page orientation, 
and the position of the image area on the printed page. 

n Fonts. Use this tab to set the font, size, and features of the various text elements such as column 
headings, in the result set printout. 

n Text. Use this tab to change the default headers, footers, page numbers, and titles. 

The Page Setup dialog also contains the following controls:

n Print. Print the result set to the currently selected printer.

n Print Preview. Preview the result set printout before printing. 

n Restore. Restore the default page setup settings.

n OK. Close the dialog and save page setup changes.

n Cancel. Close the dialog without saving page setup changes.
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You use the Layout tab in the Page Setup dialog to set the style of the grid lines, the size of each margin, 
the page orientation, and the position of the image area on the printed page. A graphic in the lower right 
corner of the tab provides a visual indication of the page layout and highlights in red text the currently 
selected page setup parameter.

The purpose of each control in the Line styles group box is explained below:

n Line. Select a line type. The line types you can select are: Border, Row dividers, and Column 
dividers. Once you select a line type, you can choose one of the following characteristics to apply 
to the line type: Omit, Light, Normal, or Heavy.

The purpose of each control in the Margins group box is explained below:

n Top. Type or select a value for the top margin.

n Bottom. Type or select a value for bottom margin.

n Left. Type or select a value for the left margin.

n Right. Type or select a value for the right margin.

The purpose of each control in the Orientation group box is explained below:

n Portrait. Print the result set in portrait format.

n Landscape. Print the result set in landscape format.

The purpose of each control in the Position on Page group box is explained below:

n Left. Print the result set image area on the left side of the image area on the printed page.

n Center. Print the result set image area in the center of the image area on the printed page.

n Right. Print the result set image area on the right side of the image area on the printed page.

Related Topics
    Specifying the Page Setup for a Result Set Printout
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You can use fonts to enhance the appearance of a result set and make it easier to view and understand. 
You can apply different fonts to the different text elements that appear in a result set printout. You can 
use the Fonts tab of the Page Setup dialog to set the font, size, and features of the various text 
elements.

The purpose of each control on the Fonts tab is explained below:

n Element. Select the text element to which you want to apply font characteristics. The available 
element types are: Title, Column headings, Headers and footers, and Body text.

n Font. Select the type font, such as Arial.

n Size. Type or select the font size in points, such as 8 point.

n Features. Select one or more of the following features: Bold, Italic, or Underline to apply to the 
currently selected text element.

n Sample. Displays sample text that reflects the currently selected font characteristics.

Related Topics
    Specifying the Page Setup for a Result Set Printout
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You can customize the appearance of a result set printout by changing the default headers, footers, 
page numbers, and titles that appear on the printed result sets. You can use the Text tab of the Page 
Setup dialog to change the default text elements.

The purpose of each control on the Text tab is explained below:

n Element. Select the text element to which you want to apply font characteristics. The available text 
elements are: Title, Header, Footer, and Page number.

n Position. Select the alignment (Left, Center, Right, Inside, or Outside) of the selected text element. 
When you select the page number element, you can also click either the Top or Bottom button to 
position the page number at the top or bottom of each page.

n Template. Accept the default macro, select any combination of the default macros, or type the text 
you want to appear as the selected text element. The list of default macros includes: Page Number, 
Current time, Current Date, Title, Title with Details, Report Folder, First Row on Page, Last Row on 
Page, Object, and User.

n Sample. Displays a sample of the selected text elemet with any defined macros expanded to show 
real values. 

Related Topics
    Specifying the Page Setup for a Result Set Printout
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You can preview each page of a result set before you print it using the Print Preview feature in the 
Report Browser. This feature is particularly helpful if you make changes to the layout, headers and 
footers, page numbers, a title, or the page margins; and you want to see how the changes will appear in 
the printed result set.

When you click the Print Preview button  on the Report Browser toolbar, choose Print Preview from the 
Report Browser File menu, or click the Print Preview button in the Print Result Set or Page Setup 
dialogs, the Report Browser opens the Print Preview dialog.

The purpose of each control in the Print Preview dialog is explained below:

n Print. Print the result set as it is shown in the preview area.

n Next Page. Display the next page of the result set in the preview area.

n Prev Page. Display the previous page of the result set in the preview area.

n One Page/Two Page. Toggle the print preview display to show either a single page or two pages of 
the result set you are printing.

n Zoom in. Increase the magnification of the view of the result set in the preview area.

n Zoom out. Decrease the magnification of the view of the result set in the preview area.

n Close. Close the Print Preview dialog.

Related Topics
    To preview a result set before printing
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n Choose any one of the following:

n Click the Preview button on the Report Browser toolbar.

n Choose Print Preview on the Report Browser File menu.

n Click the Print Preview button in the Print Result Set or Page Setup dialog.

n Right-click on a result set in the tree control and choose Preview result set ‘<result set 
name>’ on the shortcut menu.
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You can export a result set generated by the Report Browser to a comma-separated values (CSV) or 
HyperText Markup Language (HTML) file. You can also export a result set to RPTwin, the Logic Works 
reporting tool or another application that supports Dynamic Data Exchange (DDE), such as Microsoft 
Word. 

When you choose Export on the Report Browser File menu or click the Export button in the Print Result 
Set dialog, the Report Browser opens the Export from Report Browser dialog.

The purpose of each control in the Export from Report Browser dialog is explained below:

n Export format. Select the format or destination of the output as follows:

n CSV. Export the result set in comma-separated values (CSV) format. The resulting output can 
be imported by most spreadsheet applications including Microsoft Excel.

n HTML. Export the result set in HTML format. The resulting output can be displayed in any Web 
browser or imported into another application such as Microsoft Word or Excel.

n DDE. Export the result set to another application that supports Dynamic Data Exchange (DDE) 
such as Microsoft Word. 

n RPTwin. Export the result set to RPTwin, the Logic Works reporting tool.

n Export. Export the result set.

n Cancel. Cancel the export operation.

The purpose of each control in the Presentation group box is explained below:

n Tabular. Export the result set in a format similar to the format in which the result set is displayed on 
screen. Click here for an example.

n Master-detail. Export the result set in a format that uses a combination of headings and tables. 
The Report Browser uses the relationships between model components to determine which values 
are printed in headings and which values are printed in tables. Click here for an example.

n Indented. Export the result set as an indented list. The Report Browser uses the relationships 
between model components to determine how the values are indented. Click here for an example.

n One Item per line. Export a result set with one item on each line. Click here for an example.

The purpose of each control in the Export to group box is explained below:

n File. Export the result set to a file. This option is not available if you select DDE as the export 
format.

n Clipboard. Export the result set to the Clipboard. This option is not available if you select DDE or 
RPTwin as the export format.

Related Topics
    To export a result set
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1. Choose Print from the File menu. The Report Browser opens the Print Result Set dialog.

2. Click the Export button. The Report Browser opens the Export from Report Browser dialog.

3. Choose one of the following options in the Export format list:

n To generate a comma-separated values (CSV) file, choose CSV.

n To generate an HTML file, choose HTML.

n To output the result set to RPTwin, choose RPTwin.

n To output the result set to another DDE application, choose DDE.

4. Choose one of the following options in the Presentation group box:

n To generate a result set in a tabular format similar to the manner in which the result set is 
displayed on screen, click Tabular. Click here for an example.

n To generate a result set as a mix of headings and subtables, click Master-detail. Click here for 
an example.

n To generate a result set as a mix of headings and lists, click Indented. Click here for an 
example.

n To generate a result set as a list with one item on each line, click Item per line. Click here for 
an example.

5. Choose one of the following options in the Export to group box:

n To export the result set to a file, click File.

n To export the result set to the Clipboard, click Clipboard.

6. Click Export.

Note: If you select RPTwin as the output format and RPTwin is not available on your computer, the first 
time you try to export a result set to RPTwin, ERwin displays a message indicating that it cannot 
find RPTwin. Contact your Logic Works representative to obtain a copy of RPTwin.
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You can exit the Report Browser using any of the standard Windows techniques for closing applications.

The Report Browser saves any report views ( ) you create for future sessions, However, it does not 
automatically save report result sets (

). If you want to save your result sets for the next session, you must explicitly move them to a new 
folder.

Related Topics
    To exit the Report Browser
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n Choose Exit on the Report Browser File menu.

Note: The Report Browser does not automatically save report result sets ( ). If you want to save your 
result sets for the next session, you must explicitly move them to a new folder.
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The Report Browser is a powerful tool for browsing and reporting on ModelMart information. When a 
ModelMart client such as, ERwin or BPwin, has a connection to ModelMart, the tree control in the Report 
Browser shows two nodes for ModelMart information, General and ModelMart <Name>. The General 
node node contains predefined reports for generic information in the ModelMart, for example, information 
about all the ModelMart diagrams in the ModelMart, such as diagram ID, diagram name, and so on. The 
ModelMart <Name> node contains reports on specific ModelMart objects, for example, the 
videostore..movies.er1 diagram.

You can also open the Report Browser from the ModelMart Change Control Manager, the ModelMart 
Library Manager, and the ModelMart Security Manager. When you open the Report Browser from one of 
these managers, the Report Browser tree control shows a folder with reports specific to the ModelMart 
manager from which the Report Browser was opened.

After you run a report and generate a result set, you can customize the content and appearance of the 
result set and create and save you own custom report views. You can use the Report Browser search 
features to find information in the result set. You can also specify a search expression, which can include 
strings, numbers, or dates, for one or more columns so that the ModelMart Report Browser finds only the 
result set rows that satisfy all the search expressions. You can also find a change of value in a column 
and hide result sets rows that do not match the search.

Typically, you can use a result set row from one report to generate another report. When you select a 
row in the currently displayed result set, there is a feature for indicating which reports in the tree control 
are available to the selected result set row. Using this feature, you can create a thread of linked reports 
where each report provides more detailed information.

You can use the Report Browser to find objects in the ModelMart. For example, you can find which 
library or diagram contains a specific object simply by dropping a row corresponding to an object in a 
report onto the ModelMart node in the tree. You can also open a ModelMart diagram or subject area by 
dragging its icon from the tree control into the ModelMart window.

Related Topics
    ModelMart Nodes in the Report Browser Tree Control
    Summary of Tree Control Symbols for ModelMart Objects
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The tree control in the Report Browser shows the reports and result sets as an indented outline based on 
their logical hierarchical relationship. The caption bar above the tree control shows the currently selected 
root node of the tree.

When a ModelMart client such as ERwin or BPwin has a connection to ModelMart and you open the 
ModelMart Browser, the tree control shows two nodes in addition to the ERwin Reports node as follows:

n General. This is the base node for a folder hierarchy of predefined ModelMart reports, customized 
report views, and result sets. When you click the expand symbol  next to the General folder, it 
expands to show subfolders of predefined reports organized by category.

n ModelMart <NAME>. This is the base node for the ModelMart object hierarchy extended to show 
the reports, customized report views, and the result sets associated with specific ModelMart 
objects. You open an object by clicking the expand symbol  next to the object. When you open 
the ModelMart, it expands to show the libraries in the ModelMart. When you open a library, it 
expands to show the diagrams in the library. When you open a diagram, it expands to show the 
subject areas and snapshots associated with that diagram. The reports applicable to each object 
(that is, Library, Diagram, Subject Area, and Snapshot) are shown below the object in the tree.

The Report Browser displays one of the following folders when opened from the corresponding 
ModelMart manager dialog:

n Script Reports. This folder is displayed when you click the Report Browser button in the 
ModelMart Change Control Manager toolbar. The reports in this folder generate result sets that 
contain information about about model changes and conflicts.

n Library Reports. This folder is displayed when you click the Report button in the ModelMart 
Library Manager dialog. The report in this folder generates a result set that contains details about 
the objects in each ModelMart library.

n Security Reports. This folder is displayed when you click the Report button in the ModelMart 
Security Manager dialog. The report in this folder generates a result set that contains details about 
the security profile assigned to each ModelMart user and the permissions granted in each security 
profile.

Related Topics
    To view ModelMart reports by category
    To view reports by ModelMart object
    Summary of Tree Control Symbols for ModelMart Objects
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n Choose Reports by Category on the View menu.

OR

n Click on the General folder, then click the Make Selected folder the Root button .
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n Choose Reports by ModelMart Object on the View menu.

OR

n Click on the ModelMart <NAME> folder, then click the Make Selected folder the Root button .
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In addition to the standard symbols for Report Folder ( ), Report (

), Result Set (
), and Report View (
), the tree control uses the symbols in the following table to identify ModelMart objects.

Summary of Tree Control Symbols for ModelMart Objects

Symbol Meaning

ModelMart

ModelMart Library

ModelMart Diagram

ModelMart Subject Area

Snapshots

Generating a ModelMart Report {ewc HLP25632,HLP256_TILE,water.bmp}

You can use the Report Browser to retrieve information from the ModelMart in a number of ways:

n You can generate one of the pre-defined ModelMart reports ( ) supplied with the Report Browser. 
A predefined ModelMart report is a SQL query that returns the requested result set from the 
ModelMart. For example, the Diagrams report (in the General folder) is a predefined report that 
returns information about each diagram in the ModelMart such as, diagram ID, diagram name, 
number of entities, number of attributes, and so on.

n In a result set, you can use a row that identifies a ModelMart object to generate a report available 
for objects of that class. For example, if a result set row identifies a diagram, all of the reports in the 
Diagrams folder are available to the user for that row. For many reports, a result set row identifies 
several different objects which means that there are many different reports available to that row.

In the Report Browser, you can drag a result set row onto any one of the available reports to 
generate the selected report. You can use this feature to create a chain of related reports where 
each report provides more detailed information about the objects in reports higher up in the 
hierarchy. For example, you can drag a row from the Diagrams report (which shows diagram 
information) and drop it on the Entity report (in the Diagrams Reports folder) to generate a new 
report that shows entity information (that is, entity name, corresponding table name, entity 
definition) for each entity in the diagram.

When the Report Browser generates a result set ( ) for a ModelMart report, it assigns a name according 
to the following convention:

<report type> <report name> (<time> <number of rows>)

where,

n <report type> is the type of the report that generated the result set.

n <report name> is the name of the report that generated the result set.

n <time> is the time the result set was generated.

n <number of rows> is the number of rows in the result set.

While the Report Browser is generating a report, it displays the ModelMart Query dialog. If you click 
Cancel while a report is being generated, the Report Browser does not display a result set (that is, 
incomplete result sets ( ) are never displayed).

If a report does not generate a result set, the Report Browser displays a message indicating that the 
requested report doesn’t contain any rows. Click OK to continue.



When you drop a result set row onto a report icon, or double-click on a report in the Available Reports 
dialog, the Report Browser uses parameter values from the selected row to generate the report. 
Typically, a parameter value is a ModelMart object identifier, but it can also be the name of an object or 
even a string that allows wildcard operators. Some of the predefined reports require that you enter one 
or more parameters before the report is generated.

When you choose a report that requires parameter values, the Report Browser displays the ModelMart 
Query Parameter dialog that prompts you to enter the parameter values. You must enter the value of the 
parameter you are interested in before the Report Browser can generate the report.

You can also click the Display browser history button  to open the Result Set History dialog to display a 
list of all the result sets generated in the current ERwin and ModelMart sessions in chronological order. 
You can then display or delete one or more of the result sets. See To display a history of generated 
result sets  for more information. 

When you double-click on a result set in the History dialog, the result set is displayed in the Result Set 
area, but the icon for that result set is also highlighted in the tree control. This is an easy way to locate 
the result set icon that corresponds to a result set.

After you generate a result set for a report, you can then use the Report Browser’s extensive range of 
features to further customize the content and change the appearance of the result set. See Customizing 
a Result Set View  for more information.

Note: A result set for a ModelMart report exists only during the ModelMart session. If you want to keep 
a result set for the next ModelMart session, you must create a folder and move the result set to it. 
See To save a result set for the next ModelMart session   for more information.

Related Topics
    To generate a ModelMart report



To generate a ModelMart report {ewc HLP25632,HLP256_TILE,water.bmp}

1. Open the report folder ( ) in the tree control that contains the report (
) you want, then double-click on the report.

OR
Choose the report from the list box on the toolbar, then click the Execute report button  if the 

report is one that you run frequently.
OR
Right-click on a report ( ) and choose Execute Report <report name> from the shortcut menu.

2. If the report requires parameter values, the Report Browser opens the ModelMart Query 
Parameter dialog. Enter the parameter value and click OK. The Report Browser displays the result 
set generated by the report in the Result Set area and adds an icon for the result set ( ) to the 
tree under the report icon.

Note: In Step 1 above, you can click on the report, then click the Execute report button  in the toolbar 
to generate the report. You can also click on the report and choose the Execute Report option on 
the File menu.



Using a Result Set Row to Generate a Report {ewc HLP25632,HLP256_TILE,water.bmp}

Once you generate a ModelMart report, you can generally use a row from the result set ( ) to generate 
another report. The Report Browser provides two ways of doing this.

n Simply drag the result set row onto the report you want in the tree control if you know which reports 
are available for a result set row.

n Click on the result set row, then click the Find Report for Selected Row button  if you do not know 
which reports are available to a result set row. The Report Browser displays the Available Reports 
dialog which is a tree control containing the reports available to the selected row. Double-click on 
the report you want in the Available Reports dialog to generate the new report.

When you create a new report with either of the two methods described above, the Report Browser 
automatically creates a link between the source report and the newly created report. 

When the newly created report is displayed, you can click the    Display prior linked result set button  to 
display the source report again.

Related Topics
    To generate a report using a result set row
    To generate a report from the reports available list
    To display a previously linked result set



To generate a report using a result set row {ewc HLP25632,HLP256_TILE,water.bmp}

1. Double-click on a previously generated result set ( ) in the tree control to display the result set in 
the Result Set area.

2. Drag a row from the Result Set area and drop it on one of the appropriate reports ( ) in the tree 
control. The Report Browser displays the result set for the report in the Result Set area and adds 
an icon for the newly generated result set to the tree control.

Note: By clicking the Display prior linked result set button , you can easily return to the source result 
set since the Report Browser maintains a link between the source result set and the newly 
generated result set.



To generate a report from the reports available list {ewc 
HLP25632,HLP256_TILE,water.bmp}

1. Double-click on a previously generated result set ( ) in the tree control. The Report Browser 
displays the result set in the Result Set area.

2. Click on a row in the result set.

3. Click the Find reports for selected row button  on the toolbar to open the Available Reports 
dialog. The tree control in this dialog displays only the reports appropriate to the selected result set 
row.

4. Double-click on any report to generate that report for the currently selected result set row.

Note: By clicking the Display prior linked result set button , you can easily return to the source 
result set since the Report Browser maintains a link between the source result set and the newly 
generated result set.



To display a previously linked result set {ewc HLP25632,HLP256_TILE,water.bmp}

1. Double-click on the result set that has a link to a previously generated result set.

2. Click the Display prior linked result set button . The Report Browser displays the source result 
set from which the selected result set was generated.



Saving the Result Set for a ModelMart Report {ewc HLP25632,HLP256_TILE,water.bmp}

If you want the result sets for a ModelMart report to be available in the next ModelMart session, you 
must explicitly save the result set in a folder you have created. See To create a new report folder   for 
more information. After you create the new folder, you can drag and drop a result set into the new folder. 

You can also save a result set to a file. See Exporting a Result Set for more information. 

Related Topics
    To save a result set for the next ModelMart session



To save a result set for the next ModelMart session {ewc 
HLP25632,HLP256_TILE,water.bmp}

1. Locate the report folder where you want to store the result set or create a new report folder. See To 
create a new report folder  for more information. 

2. Drag the result set icon ( ) for the report you want to save into the newly created folder. The 
Report Browser saves your result set for the next ModelMart session.

Note: You can create your own hierarchy of folders. For example, you can create a folder for each 
modeling project and create subfolders under the project folders organized by modeler or by time, 
for example, a week’s worth of daily change reports.



Creating a ModelMart Library Manager Report {ewc 
HLP25632,HLP256_TILE,water.bmp}

When you click the Report button in the ModelMart Library Manager dialog, the Report Browser opens. 
The tree control in the Report Browser displays a Library Reports folder that contains one predefined 
Library Report. When you double-click on the Library Report icon in the tree control, the Report Browser 
generates a result set that provides information about the objects in each ModelMart library. 

After you generate the report, you can use the Report Browser features to customize the appearance of 
a result set, find one or more specific items in the result set, print the result set, or export the result set. 
See Customizing a Result Set View  .

Note: You can also generate a report on changes you have made using the ModelMart Security 
Manager. See Creating a ModelMart Change Control Manager Report  .

Related Topics
    To create a ModelMart Library Manager Report
    ModelMart Library Manager Report Content
    Sample ModelMart Library Manager Report



To create a ModelMart Library Manager Report {ewc 
HLP25632,HLP256_TILE,water.bmp}

1. In the ModelMart Library Manager dialog, click the Report button. The Report Browser opens.

2. In the Report Browser tree control, open the Library Reports folder.

3. Double-click on the Library Report icon. The Report Browser generates a result set that contains 
information about the objects in each ModelMart library.

Related Topics
    Sample ModelMart Library Manager Report



ModelMart Library Manager Report Content {ewc HLP25632,HLP256_TILE,water.bmp}

The standard Library Report generates a result set with the following information:

n Object Class. The class of the object as it appears in the ModelMart Library Manager dialog. For 
example, library, diagram, subject area.

n Object Name. The name of the object as it appears in the ModelMart Library Manager dialog. For 
example, videostore, movie1, movie1;1.

n Owner Class. The object class of the owner of the library, diagram, or subject area as it appears in 
the ModelMart Library Manager dialog. For example, ModelMart, library, diagram.

n Owner Name. The name of the owner of the library, diagram, subject area, etc. as it appears in the 
ModelMart Library Manager dialog. For example, videostore, movies.

n Object Description. The user-defined description for the library, diagram, subject area, snapshot, 
archive, or version. For example, 9/2/99 Test Version.

n Updated By. The name of the ModelMart user who last modified the library, diagram, or subject 
area and saved changes to ModelMart (for example, JSMITH).

n Created By. The name of the ModelMart user who created the library, diagram, or subject area and 
saved it to ModelMart (for example, JSMITH).

n Updated. The date that the library, diagram, or subject area was last saved to ModelMart (for 
example, Jan 15 1999 12:00 AM).

n Created. The date that the library, diagram, or subject area was created and saved to ModelMart 
(for example, Jan 15 1999 12:00 AM).



Sample ModelMart Library Manager Report {ewc HLP25632,HLP256_TILE,water.bmp}

The report shown below is an example of a ModelMart Library Manager report.

Related Topics
    ModelMart Library Manager Report Content



ModelMart Editable Reports and User Defined Property Reports

Using the Report Browser, you can make changes directly into the ModelMart, without loading any 
diagrams. You can modify many object properties, such as entity definitions and relationship verb 
phrases. You can even extend the ModelMart by adding new properties of your own.

You can use the Report Browser to enter and edit information in the ModelMart using the following 
editable reports:

n User-Defined Property Report.  Use to define new properties for any object class in an ERwin 
diagram. 

n Property Reports. Use to assign a value to individual object properties, including user-defined 
properties, and report on these properties from the Report Browser. Property Reports include:

· Diagram Object Property Reports. Use to view and edit properties of diagram objects, such 
as entities and attributes.

· Library Object Property Reports. Use to view and edit properties of library objects, such as 
domains.

· Definition and Relationship Label Reports. Use to quickly enter and edit entity definitions, 
attribute definitions, or relationship parent-child verb phrase.

The changes you make to your ModelMart using the Report Browser are governed by exactly the same 
security and synchronization constraints that govern changes made via the ERwin diagram editor. Like 
ERwin, the Report Browser enforces both user profile permissions and diagram locking.



Working with ModelMart Editable Reports

ModelMart Editable reports are listed in the General report option list in the Report Browser tree control.

You can use editable report to enter and edit object property information. For example, with the Edit 
Attribute Definitions report, you can edit the definitions for all attributes in any diagram in the ModelMart. 

To run a report, double-click on the report name and select or enter the parameters for the report when 
prompted.

If the report returns one or more rows to the Report Browser, the resulting rows are displayed in the 
Result Set Area of the Report Browser. Like other reports, the Report Browser saves the result set of an 
editable report as a named report in the report hierarchy. Each new report is listed in the Report Browser 
under the editable report option that you used to generate it.

Note: You can also run an editable report from the Available Reports dialog. To view the available 
report, including editable reports, for a ModelMart object, select the object's row in a report, then 
click the Available Reports button.



Working with the Create User-Defined Properties Report

When you double-click on the Create User-Defined Properties report in the Report Browser report tree, 
the Report Browser queries the ModelMart and displays all object classes and their editable properties in 
the Result Set Area.

The property list includes properties available in ERwin, such as definition or parent-child verb phrase, 
as well as any existing user-defined properties.

To edit the result set for the Create User-Defined Properties report, scroll to the end of the report and 
click in the empty row.

When you click on the Class column, the Report Browser opens a list box that provides a complete list of 
all object classes in an ERwin model. Choose the object class that you want to associate with a user-
defined property, then click on the Property column to enter a new name for the user-defined property.

When you are finished editing, click the Commit changes button  to save your changes.

You can use other reports in the Report Browser to assign values to a user-defined property for one or 
more objects in the associated class. For example, if you create the “Location of Target Server” property 
and assign it to the Diagram object class, you can then use the Edit Library Object Properties by 
Property report to view all diagrams in the library and assign a value to the new user-defined property. 



To add a user-defined property to the ModelMart

1. Click the expand button  next to the General report folder.

2. Click the expand button  next to the Editable Reports folder.

3. Double-click on the Create User-Defined Properties report.

4. Select the blank row at the end of the report.

5. Click on the Class field to select the object class to which you want to assign a user-defined 
property.

6. Click on the Property field and type the name of the new user-defined property.

7. Click the Commit changes  to save your changes.

8. Click OK.



Working with Property Reports

You can use the Property reports in the Report Browser to edit many different object properties and save 
the changes to the ModelMart. These reports can be conceptually grouped as follows:

n Diagram Object Property Reports. Use to view and edit properties of diagram objects, such as 
entities and attributes. The report is filtered to show properties by class or a single property for all 
classes. Diagram Object Property Reports include:

· Edit Diagram Object Properties by Class

· Edit Diagram Object Property by Property

n Library Object Property Reports. Use to view and edit properties of library objects, such as 
domains. The report is filtered to show all editable properties for each object class or a single 
property for all classes. Library Object Property Reports include:

· Edit Library Object Properties by Class

· Edit Library Object Property by Property

n Definition and Relationship Label Reports. Use to quickly enter and edit entity definitions, 
attribute definitions, or relationship parent-child verb phrases. Unlike the other Property reports, 
these reports are filtered to show only a single property for the specified object class. Definition and 
Relationship Label Reports include:

· Edit Entity Definitions

· Edit Attribute Definitions

· Edit Relationship Labels

These reports are discussed fully later in this chapter.



Editing Object Properties in the Report Browser

Each Diagram Object Property report and Library Object Property report includes two or more columns. 
Use the Report Browser to edit the values that appear in the Value, Definition, or Phrase columns.

To help you discover which values are editable, the cursor automatically displays as a pencil when you 
pass it over an editable field in a selected row.

When you click on an editable field with the pencil cursor, the Report Browser opens an edit box for that 
field. You can use the standard keyboard editing keys to enter, modify, or delete the existing value. 

Click the Commit changes button  in the Report Browser toolbar or click on the report outside of the 
edit box to save your changes to the ModelMart. You are then prompted to confirm or cancel the 
changes to the ModelMart.

While you are editing a field in the Report Browser, you can click the ESC (Escape) key to cancel any 
changes you have made to the selected row.

To edit larger blocks of text, you may want to open the Report Browser's editing window. To open the 
editing window, click with the pencil cursor to open the edit box, then press the CTRL+ENTER key 
combination to open a larger editing window.

When you have completed your changes, click the OK button to close the editing window and save your 
changes to the ModelMart.

Note: The Report Browser saves the changes to the ModelMart after each change. If the Library that 
contains the affected ModelMart diagram has Auto Archive option enabled, an archive of the 
diagram is also saved after each change.



Working with Diagram Object Property Reports

Diagram Object Property reports include:

n Edit Diagram Object Properties by Class. Use to select the diagram and class of diagram object 
that you want to edit. The report displays all objects of the selected class that appear in the 
diagram. You can edit all available property values for each object. The example below shows a 
report on all entity properties in the MOVIES model. 

n Edit Diagram Object Property by Property. Use to select the diagram and property that you want 
to edit. The report displays all classes of objects in the diagram. You can edit the specified property 
value for each object. The example below shows a report on the Definition property for all object 
classes in the MOVIES model.

To run a Diagram Object Property report in the Report Browser, you must provide the diagram ID number 
when prompted, or drag a diagram name from a different report onto the report name. You can use the 
resulting report to edit the property values that appear in the Value column. 

In addition to standard property values, you can also edit all user-defined property values for each object 
in the diagram. The specific user-defined property you want to edit must have already been added to the 
ModelMart using the Create User-Defined Properties report. 



To edit diagram object properties in the Report Browser

1. Click the expand button  next to the General report folder.

2. Click the expand button  next to the Global Report folder.

3. Double-click on the Diagrams report. Using this report, you can select the diagram you want to use 
to create an editable report.

4. Click the expand button  next to the Editable Reports folder.

5. Select the diagram you want edit in the Result Set Area of the Report Browser, then drag and drop 
it on a Diagram Object Property report. If you dropped the diagram name on the:

n Edit Diagram Object Properties by Class report, the Report Browser prompts you to select 
an object class.

n Edit Diagram Object Property by Property report, the Report Browser prompts you to select 
a property.

6. After you select an object class or property, click OK. The Report Browser displays the new 
editable report in the Result Set Area.

7. Select the property value you want to edit, then click on the value field with the pencil cursor.

8. Enter or edit the selected property value using the standard keyboard editing keys.

9. Click the Commit changes button  to close the edit box and save your changes.

10. Click OK to save your changes to the ModelMart.



Working with Library Object Property Reports 

Library Object Property reports include:

n Edit Library Object Properties by Class. Use to select the library and class of library object that 
you want to edit. The report displays all objects of the selected class that appear in the library. You 
can edit all available property values for each object. The example below shows a report on all 
diagram properties in the Videostore library.

n Edit Library Object Property by Property. Use to select the library and property that you want to 
edit. The report displays all classes of library objects. You can edit the specified property value for 
each object. The example below shows a report on the Definition property for all object classes in 
the Videostore library.

To run a Library Object Property report in the Report Browser, you must provide the library ID number 
when prompted or drag a library name from a different report onto the report name. You can use the 
resulting report to edit the property values that appear in the Value column. 

In addition to standard property values, you can also edit all user-defined property values for each object 
in the library. The specific user-defined property you want to edit must have already been added to the 
ModelMart using the Create User-Defined Properties report. 



To edit library object properties in the Report Browser

1. Click the expand button  next to the General report folder.

2. Click the expand button  next to the Global Report folder.

3. Double-click on the Libraries report. Using this report, you can select the library you want to use to 
create an editable report.

4. Click the expand button  next to the Editable Reports folder.

5. Select the diagram you want to edit in the Result Set Area of the Report Browser, then drag and 
drop it on a Library Object Property report. If you dropped the library name on the:

n Edit Library Object Properties by Class report, the Report Browser prompts you to select an 
object class.

n Edit Library Object Property by Property report, the Report Browser prompts you to select a 
property.

6. After you select an object class or property, click OK. The Report Browser displays the new 
editable report in the Result Set Area.

7. Select the property value you want to edit, then click on the value field with the pencil cursor.

8. Enter or edit the selected property value using the standard keyboard editing keys.

9. Click the Commit changes button  to close the edit box and save your changes.

10. Click OK to save your changes to the ModelMart.



To assign user-defined properties in the Report Browser

1. Click the expand button  next to the General Report folder.

2. Click the expand button  next to the Global Report folder.

3. Choose one of the following actions:

n To locate the library that contains the object you want to edit, double-click on the Libraries 
report.

n To locate the diagram that contains the object you want to edit, double-click on the Diagrams 
report.

4. Click the expand button  next to the Editable Reports folder.

5. Choose one of the following options:

n To edit user-defined properties for library objects, select the library you want to edit in the 
Result Set Area of the Report Browser, then drag and drop it on the Edit Library Object 
Property by Property report.

n To edit user-defined properties for diagram objects, select the diagram you want to edit in the 
Result Set Area of the Report Browser, then drag and drop it on the Edit Diagram Object 
Property by Property report.

6. When the Report Browser prompts you to select a property, select a user-defined property name in 
the drop-down list.

7. Click OK. The Report Browser displays the new editable report in the Result Set Area.

8. Select the value you want to edit, then click on the value field with the pencil cursor.

9. Enter or edit the value for the user-defined property using the standard keyboard editing keys.

10. Click the Commit changes button  to close the edit box and save your changes.

11. Click OK to save your changes to the ModelMart.



Working with Definition and Relationship Label Reports

Definition and Relationship Label reports are special types of diagram property reports that preselect the 
object class and property displayed in the report. To run a Definition or Relationship Label report in the 
Report Browser, you must provide the diagram ID number when prompted or drag a diagram name onto 
the report name. 

Definition and Relationship Label Reports include:

n Edit Attribute Definitions. The resulting report displays the entity name, attribute name, and 
attribute definition for the selected diagram. You can edit attribute definitions in this report.

n Edit Entity Definitions. The resulting report displays the entity name and entity definition for the 
selected diagram. You can edit entity definitions in this report.

n Edit Relationship Labels. The resulting report displays the parent entity name, relationship 
parent-child verb phrase, and child entity name for each relationship in the selected diagram. You 
can edit the verb phrase in this report.



To edit definitions or relationship verb phrases in the Report Browser

1. Click the expand button  next to the General report folder.

2. Click the expand button  next to the Global Report folder.

3. Double-click on the Diagrams report. Using this report, you can select the diagram you want to use 
to create an editable report.

4. Select the diagram you want to edit.

5. Choose one of the following options:

n To edit entity definitions, drag and drop the diagram name on the Edit Entity Definitions 
report.

n To edit attribute definitions, drag and drop the diagram name on the Edit Attribute Definitions 
report.

n To edit relationship parent-child verb phrases, drag and drop the diagram name on the Edit 
Relationship Label report.

6. After the Report Browser displays the new result set, click on any row in the result set to select it.

7. Click on the Definition field or the Phrase field for the selected row. The Report Browser opens a 
scrollable edit box for the selected field, as shown below.

8. Use the standard editing keys to modify the value.

9. Click the Commit changes button  to close the edit box and save your changes.

10. Click OK to save the change in the ModelMart.

Note: The Report Browser saves the changes to the ModelMart after each change. If the Library that 
contains the affected ModelMart diagram has Auto Archive option enabled, an archive of the 
diagram is also saved after each change.



Summary of Editable Classes and Properties

The following table lists the editable properties for each object in a model.

Class Property

Attribute Definition
Note

Column --
Diagram Description
Domain Definition
Entity Definition

Icon
Note
Owner
Query
Sample

Index File Name
For Expression
Key Expression

Library Auto-Archive
Description

Physical Object Definition
Display Format Type
Edit Style Type
Template Code
Trigger Code
Trigger New
Trigger Old
Trigger Type

Relationship Parent-child Verb Phrase
Definition

Report Report
Report List
Report Options
Report Type

Stored Display Author
Definition
Print Info

Subject Area Author
Definition

Table Location
Owner

Text Block Contents

Note: You can also associate an object class with one or more user-defined properties. User-defined 
properties are named and associated with an object class in the Create User-Defined Properties 
report. You can assign a value to a user-defined property in the Diagram Object Property reports 
or Library Object Property reports.



Summary of ModleMart Editable Reports

The following table lists the editable reports in the Report Browser, the user-supplied parameters 
required to run the report query, valid class or property parameters, the editable fields in the result set, 
and a description of the contents of the result set.

Report Name Parameter 
Type(s)

Valid Parameters Editable 
Column(s)

Description

Create User-
Defined 
Properties

None (reports 
on the entire 
ModelMart).

N/A Class and 
Property

You can create new user-
defined properties for 
any class of ModelMart 
objects.

Edit Attribute 
Definitions

Diagram ID. N/A Definition You can enter or update 
the attribute definitions in 
the selected ModelMart 
model.

Edit Diagram 
Object 
Properties by 
Class

Object Class 
and Diagram 
ID.

Entity
Domain
Relationship
Attribute
Table
Column
Attribute Group
Index
Index Member
User
Text Block
Physical Object
Subject Area
Stored Display
Report
Synonym

Value Diagram property report 
filtered on object class. 
You can enter or edit 
property values for each 
object in the class and 
diagram selected.

Edit Diagram 
Object 
Property by 
Property

Property Name 
and Diagram 
ID.

Value Diagram property report 
filtered on property. You 
can enter or edit property 
values for all objects 
associated with the 
selected property.

Edit Entity 
Definitions

Diagram ID. N/A Definition You can enter or update 
the entity definitions in 
the selected ModelMart 
model.

Edit Library 
Object 
Properties by 
Class

Object Class 
and Library ID.

Domain
Physical Object
Diagram

Value Library property report 
filtered on object class. 
You can enter or edit 
property values for each 
object in the class and 
diagram selected.

Edit Library 
Object 
Property by 
Property

Property Name 
and Library ID.

Value Library property report 
filtered on property. You 
can enter or edit property 
values for all objects 
associated with the 
selected property.

Edit 
Relationship 
Labels

Diagram ID. N/A Phrase You can enter or update 
the physical relationship 
name for each 
relationship in the 



selected diagram.




